Stairs, Ramps, and Railings

A whole chapter just for stairs, ramps, and railings? You bet! If you think about it, there could be hundreds of combinations of stair and railing systems. As a matter of fact, you seldom see two sets of stairs that are exactly the same. Kind of like snowflakes, aren’t they? OK, they’re nothing like snowflakes! But you get the point.

This chapter covers the following topics:

▶ Creating stairs by using the Rise/Run function
▶ Creating a winding staircase
▶ Creating a custom railing system
▶ Creating custom stairs
▶ Adding ramps

Creating Stairs by Using the Rise/Run Function

To begin, this chapter will address the makings of a staircase—from commercial stairs to those with a more residential feel with wood members, balusters, and spindles. During this procedure, you’ll see how the Autodesk® Revit® Architecture software brings stairs together. After you create a common staircase, you’ll move on to winding stairs, custom railings, and, of course, ramps.

Before you begin, I should mention that there are some stair-related features (or lack of features) in Revit you’ll love and some you won’t. As you create the stairs, keep in mind that Revit can’t always provide enough functionality to re-create every type of stair you may encounter.
Throughout this book, you’ll have the opportunity to download custom families from the book’s website.

In this section, you’ll focus on creating a staircase by using the traditional Rise/Run method. Then I’ll discuss modifying the boundary of the stairs, which allows you to create a more unusual shape than that provided out of the box.

Metric users should not type in mm or other metric abbreviations when entering amounts suggested in the exercises. Revit will not accept such abbreviations. Simply enter the number provided within the parentheses.

To begin, open the file you’ve been using to follow along. If you didn’t complete Chapter 9, “Ceilings and Interiors,” go to the book’s web page at www.sybex.com/go/revit2017ner. From there you can browse to the Chapter 10 folder and find the file called NER-10.rvt.

The objective of the following procedure is to create a staircase using the Rise/Run method:

1. In the Project Browser, go to the Level 2 floor plan.
2. Zoom in on the radial entry in the east wing, as shown in Figure 10.1.

![Figure 10.1: Click the Stair button on the Circulation panel of the Architecture tab.](image-url)
3. On the View Control bar, change Visual Style to Hidden Line.

4. On the Circulation panel of the Architecture tab, click the Stair button (see Figure 10.1).
   You’re put into Sketch Mode for the stairs you’re about to design, as shown in Figure 10.2.

   ![Figure 10.2: The Modify | Create Stair tab, Sketch Mode](image)

5. On the Components panel of the Modify | Create Stair tab, make sure the Run button and the Straight button are checked (see Figure 10.2).

6. In the Properties dialog, change Base Level to Level 1.

7. Change Top Level to Level 2.

8. Change Multistory Top Level to Level 5 (see Figure 10.3).

   ![Figure 10.3: Changing the Element Properties of the stairs](image)
**NOTE**  By setting the base to Level 1 and the top to Level 2, you give Revit the dimensions it needs to calculate the rise of the stairs. When you add the multistory height, Revit takes the calculation from Levels 1 and 2 and applies that increment up to the additional floors. Be warned, however, that if the floor-to-floor dimension changes in one of these levels, you’ll have a problem. You’ll then have to create a new staircase starting at the offending level.

9. Pick the intersection of the floor edge and grid 3.1 for the first point of the stairs. This spot is labeled 1 in Figure 10.4.

![Figure 10.4: Laying out the stairs](image)

10. Move your cursor to the right. A faint display indicates that you have a certain number of risers created and a certain number remaining.

11. When you see that nine risers have been created with nine risers remaining, pick the spot labeled 2 in Figure 10.4.

12. Move your cursor straight up (north) until you get to the grid intersection labeled 3 in Figure 10.4. When you see this, pick the third point.

13. Move your cursor to the left—all the way past the floor landing. Revit reports that you have 18 risers created and 0 remaining (see Figure 10.4).
14. When the second leg is completed, pick the last point. Revit draws both legs as well as the landing (see Figure 10.4).

With the basic layout completed, it’s time to examine the perimeter of the stairs. If you’re looking for any architectural design outside of the basic box that you get when you place a staircase, you’ll want to edit the boundary.

Modifying Boundaries

With the main stairs in place and laid out, you can now start modifying the profile. Given that this is a five-tiered, multilevel staircase, the boundary will be somewhat limited—but not to the point that you can’t make something pop out of your design.

To modify the boundary, follow these steps:

1. Select the landing, as shown in Figure 10.5.

2. Click the Convert button (see Figure 10.5).

3. When you see the warning that you may be doing irreversible damage, click Close to dismiss it.

4. With the landing still selected, click the Edit Sketch button, as shown in Figure 10.6.

---

**Figure 10.5**: The Convert button
5. On the Draw panel, click the Start-End-Radius Arc button, as shown in Figure 10.7.

**Figure 10.6**: The Edit Sketch button

**Figure 10.7**: Add a radius to the outside of the landing.
6. Draw an arc on the outside of the landing at an 8’–0” (2400 mm) radius (see Figure 10.7).

With the radius drawn in, it’s important to pause at this point. What you have here is an extra line. Similar to when you’re sketching a floor, if you have any overlapping line segments or gaps, Revit won’t let you continue. Also, if you have any extra lines, Revit won’t let you continue.

Let’s clean up the stairs.

1. Click Modify or press the Esc key twice, and then select the straight green line at the outside of the landing.

2. Press the Delete key on your keyboard. The line is removed. Your stairs should look exactly like Figure 10.8.

3. Click the Finish Edit Mode button, as shown in Figure 10.9.

Now you can select the railing system to use. Out of the box, Revit provides only four choices. You’ll select one of those choices for this staircase, but you’ll add to the list later in this chapter.
Configuring Railings

Revit provides a small number of railing systems as a default. You can choose one of these five railings to apply to the staircase during the Sketch Mode of the stairs.

Follow this procedure to apply a railing to the stairs:

1. On the Modify | Create Stair tab in Sketch Mode, click the Railing button, as shown in Figure 10.10.
2. In the Railing dialog box, from the drop-down, select Guardrail – Pipe, as shown in Figure 10.11.

![Railing dialog box](image)

**Figure 10.11:** Select Guardrail – Pipe and the Stringer radio button.

3. Under Position, select the Stringer radio button (see Figure 10.11). Doing so hosts the railing to the stringer.

4. Click OK. With the railings in place, you're on your way to completing this staircase. As a matter of fact, round one is finished.

5. To complete the stairs, click Finish Edit Mode on the Modify | Create Stair tab.

6. Close the warning that states that the rail is noncontinuous.

7. Go to Level 1. Your stairs should look like Figure 10.12.

![Staircase plan](image)

**Figure 10.12:** The stairs as displayed in the plan
Normally, when you're dealing with a large, multistory staircase, you should check it out in 3D to make sure all went as planned. This case is no exception! Here are the steps:

1. Click the Default 3D View button on the Quick Access toolbar.

2. In the 3D view, zoom in on the radial entry.

3. Select the radial wall. It becomes transparent.

Examine your stairs (see Figure 10.13).

![Image of a staircase in 3D with the radial entry temporarily transparent](https://example.com/image)

**Figure 10.13:** The stairs in 3D with the radial entry temporarily transparent

Here’s a problem: the railing just stops dead at the bottom of the stringer. This may have been acceptable practice around the time, say, when the wheel was still on the drawing board. You need some kind of Americans with Disabilities Act (ADA) compliance at the bottom of the stairs. To accomplish this, follow along with the next procedure.

To begin, go to the book’s web page, browse to the Chapter 10 folder, and find the file called ADA-Pipe.rfa. You can then download it to your computer. Now perform these steps:

1. On the Insert tab, click the Load Family button.
2. Browse to the directory where you stashed the family you just downloaded, and load ADA-Pipe.rfa into your model.

3. Go to the Level 1 floor plan.

4. Zoom in on the bottom of the stairs.

5. On the Work Plane panel of the Architecture tab, click the Ref Plane button.

6. Offset a reference plane 9 1/2” (237 mm) to the left of the bottom riser (see Figure 10.14).

7. Type 0’ in the offset field and draw another reference plane from the center line of the bottom railing to the left about 2’–0” (600 mm) (see Figure 10.14).

8. On the Architecture tab, click the Place A Component button.

9. In the Properties dialog box, select ADA – Pipe.

10. Press the spacebar once to rotate the family into place so that it’s oriented as shown in Figure 10.15.

11. Place the family at the intersection of the two reference planes (see Figure 10.15), and then press Esc twice or click Modify.
Extending the Railings

You’ve added a family to finish the stairs at the bottom. The next step is to extend the railings on the stairs to meet the new family. There is one obstacle, though: the railing on the stairs already has an ending post. The trick is to remove the default ending post and replace it with the custom ADA post you just loaded into your model.

The objective of the next procedure is to extend the railings on the stairs to the ADA posts you just added to the model:

1. In the plan, select the bottom railing, as shown in Figure 10.16. Make sure you aren’t selecting the stairs.
2. In the Properties dialog box, click the Edit Type button.

3. Click Duplicate.

4. Call the new railing Entry Stair Railing.

5. Click OK.

6. In the Baluster Placement row, click the Edit button, as shown in Figure 10.17.

![Type Properties dialog box](image)

**Figure 10.17**: Click Edit next to Baluster Placement.

At the bottom of the Edit Baluster Placement dialog box is a Posts category. In the Posts category is an option to place a post at the start, end, or corner of the railing. Follow these steps:

1. For Start Post (1) and End Post (3), type -6" (-150 mm) for the base offset, as shown in Figure 10.18.

2. Click OK twice.

3. Select the railing on the inside of the stairs.

4. Change its type to Entry Stair Railing.
It's time to stretch the railing on the stairs to meet up with the family. This procedure is best done in a plan view, where you can see exactly how far you need to stretch the railing.

1. Select the bottom (south) railing.
2. On the Modify | Railings tab, click the Edit Path button.
3. Stretch the magenta line to the point shown in Figure 10.19.

4. For the first alignment, pick the back edge of the family you loaded, as shown in Figure 10.19.
5. Pick the magenta railing line. (When you hover over the magenta line, you’ll see an endpoint icon. When you do, click it.) The magenta line extends to the family (see Figure 10.19).

6. Click Finish Edit Mode.

7. Go to the default 3D view to make sure the railings align (see Figure 10.20).

8. Select the radial brick wall.

9. On the View Control bar, click the Temporary Hide/Isolate Element button, as shown in Figure 10.20.

10. Select Hide Element (see Figure 10.20).

11. When you’ve finished marveling at your fantastic landing, click the Temporary Hide/Isolate Element button again, and select Reset Temporary Hide/Isolate.
It would be nice if this were the only place that this railing extension needed to go. The rest of the procedure will step you through the process of adding this extension to the inside railing and then copying it up to the other levels.

1. Return to the Level 1 plan view. Select the ADA – Pipe family you added to the model.

2. Click the Mirror – Pick Axis button, as shown in Figure 10.21.

3. Pick grid 3.1, and your family is mirrored.

4. Select the inside railing.

5. On the Modify | Railings tab, click the Edit Path button.

6. Click the Align button.

7. Align the magenta line with the ADA – Pipe family, as shown in Figure 10.22.

8. Press Esc twice, and then select both families.

9. On the Modify | Generic Models tab, click the Copy To Clipboard button on the Clipboard panel (the third panel from the left).
10. Choose Paste ➤ Aligned To Selected Levels, at the upper left on your screen.

11. Pick Levels 2, 3, and 4, and then click OK. Does your staircase look like Figure 10.22?

   It’s getting close, but it seems as though there is nothing keeping people from falling off the second, third, fourth, and fifth levels! I don’t know about you, but I think this is the perfect place to put a separate railing and tie it into the existing stair railing.

**Landing Railings**

Railings, of course, can be drawn independently from a stair. Tying the railing into the stair, however, requires a little more patience. That being said, it becomes obvious that Revit reflects the real world when it comes to railings. If you have a railing that is difficult to build, it will probably be difficult to model. Also, if you arrive at an intersection that can’t be physically accomplished in the field, then guess what? You’ll struggle trying to get it into Revit.
To add some railings at the landings and tie them into the stair railings, follow these steps:

1. In the Project Browser, go to the Level 2 floor plan.
2. On the Architecture tab, click the Railings button.
3. Make sure Type is set to Handrail – Pipe.
4. In the Properties dialog box, click the Edit Type button.
5. Click the Duplicate button.
6. Call the new railing Handrail – Pipe – Horizontal Railing.
7. Click the Edit button next to the Baluster Placement choice.
8. Select None for the Start and End posts under the Posts category, as shown in Figure 10.23.

9. Click OK twice.
10. Pick a point at the intersection of the reference plane and the south wall, as shown in Figure 10.24.
11. Click the Preview button on the Options bar (see Figure 10.24).

12. Pick the intersection of the reference plane and the ADA – Handrail (see Figure 10.24).

13. Click Finish Sketch.

**NOTE** You can have only one continuous railing at a time. If there are gaps in the railing, it won’t work. For example, the second floor needs three separate railings.

The next step is to add the ADA railing extensions to the north leg of the stairs and to create a railing between the two stair sections. This process can be a tad tricky, but once you get the progression, you’ll see why it needs to be done in the following manner:

1. Still on the second floor, select the two ADA – Pipe families, and click the Mirror – Pick Axis button, as shown in Figure 10.25.

2. Mirror the two families about the building’s center reference plane.

3. Select the inside railing on the staircase.

4. Click Edit Path on the Modify | Railings tab.
5. Extend the railing to the front edge of the ADA family, exactly the same way you did for the south leg of the staircase (see Figure 10.26).

6. Click Finish Edit Mode.
7. Repeat the procedure for the outside railing, as shown in Figure 10.26.

Let’s add a railing to the center and the north side of the landing. This should be pretty easy.

1. Start the Railing command.

2. Make sure Handrail – Pipe – Horizontal Railing is the current railing.

3. Draw a line down 1’–0” (300 mm) from the intersection of the upper-south ADA railing extension and the reference planes, as shown in Figure 10.27.

![Figure 10.27: Creating the middle railing](image)

4. Draw a line up 1’–0” (300 mm) from the top ADA railing extension on the south leg of the stairs (see Figure 10.27).

5. On the Draw panel, click the Start-End-Radius Arc button (see Figure 10.27).

6. Draw a 4’–0” (1200 mm) arc from the endpoints of the top and bottom lines (see Figure 10.27).

7. Click Finish Sketch.

8. Draw another railing, as shown in Figure 10.28.
What you need to do now is add this configuration to the third, fourth, and fifth floors. The fifth floor, however, will need to have a configuration change.

1. Select the middle railing, the two ADA railing extensions, and the northern railing, as shown in Figure 10.29.

2. On the Modify | Multi Select tab, click the Copy To Clipboard button (see Figure 10.29).
3. Click Paste ➔ Aligned To Selected Levels, as shown in Figure 10.30.

4. Paste the items to Level 3 through Level 5.

5. Go to Level 5.

6. Change Detail Level to Fine.

7. Delete the middle railing, and make the south railing extend to the ADA post, as shown in Figure 10.31.
8. Go to a 3D view, and select the radial brick wall to make it transparent. Check out your stairs, as shown in Figure 10.32.

Phew! You’ve built a set of stairs. The good thing is that it’s one sweet staircase. The bad thing is that you used all the default layouts and materials. Next, we’ll get into some more complicated shapes and styles.

Creating a Winding Staircase

Before you get started, you should know that you’ll create this staircase by using the separate stair components. You can try to make a winding staircase by using the Run function, similar to the one you used earlier. But in many cases (especially when you run into an existing staircase in either a renovation project or an addition), you may need to draft the stairs and then model over the top of the drafting lines. What? Drafting in Revit? Of course. How else can you expect to get anything done?

The first thing you’ll need to do is make modifications to the floor in a specific area to create a landing. Follow these steps:

1. In the Project Browser, go to the Level 2 floor plan.
2. Zoom in on the area between the corridor and the east wing, as shown in Figure 10.33.

![Figure 10.33: Creating a landing. You’ll add a door in a moment.](image)

3. Select the Level 2 floor in the east wing.

4. Click the Edit Boundary button on the Mode panel of the Modify | Floors tab.

5. Sketch a landing that is 8′–0″ (2400 mm) long × 7′–10″ (2350 mm) wide. Center it on the reference plane, as shown in Figure 10.34.

![Figure 10.34: Click the Detail Line button on the Annotate tab.](image)

6. Click Finish Edit Mode on the Mode panel. If you’re asked if you want to attach the walls to the bottom of the floor, click Yes.

With the landing in place, you can now copy a door up to this level. To do this, you’ll go to the first floor and copy the door that resides there. You can do this on your own, or you can follow along with these steps:

1. In the Project Browser, go to the Level 1 floor plan.
2. Select door 100B.

3. Copy the door to the clipboard (click Copy To Clipboard on the Clipboard panel).


5. Select Level 2, and click OK.

6. In the Project Browser, go back to Level 2. The door and the landing are in place.

Next you'll create a winding set of stairs. The first task is to lay out the shape in the plan using simple drafting lines. The second task is to model over the lines you added, by using various stair tools as follows:

1. Select the Annotate tab.

2. Click the Detail Line button.

3. On the Draw panel, click the Start-End-Radius Arc button, as shown in Figure 10.35.

![Figure 10.35](image)

**Figure 10.35:** With the Start-End-Radius Arc button selected, start at the midpoint of the landing and then go southwest at an angle of 135° and a distance of 11'–0" (3300 mm).
4. For the first point of the arc, pick the midpoint of the landing (see Figure 10.35).

5. Move your cursor down, at 135° from the first point you just picked.

6. Extend your cursor 11′–0” (3300 mm), as shown in Figure 10.36, and then click to set the second point.

7. To form the arc, move your cursor to the right until the radius snaps into place. When it does, pick the point as shown in Figure 10.36.

8. Press Esc.

9. On the Draw panel, click the Pick Lines icon.

10. On the Options bar, add an increment of 2′–0” (600 mm) to the Offset field (see Figure 10.37).

11. Offset the center arc to the right and then to the left, forming a 4′–0” (1200 mm) overall winder, as shown in Figure 10.37.

12. Press Esc.

13. Click the Line tool, make sure Offset is set to 0, and then draw a straight line at each end of the arcs, as shown in Figure 10.38.
OK, take a breather. Compare the examples in the book to what you have. Are you close? If not, go back and investigate.

**NOTE** Get used to this drafting thing; it’s still very much a part of BIM, regardless of whether people say you can’t draft in Revit!
The next step is to make an array of the straight lines you just added. These lines will wind up being the guidelines for your risers.

1. Press Esc, and then select the smaller arc, as shown in Figure 10.39.

![Figure 10.39: Selecting the smaller arc](image)

2. In the Properties dialog box, select Center Mark Visible.

3. Select the line at the left end of the arcs, as shown in Figure 10.40.

![Figure 10.40: Arraying the line to create your own treads](image)

4. Click the Array button on the Modify | Lines tab.
5. On the Options bar, be sure Radial is selected.

6. Make sure Group And Associate is selected.

7. Type 18 for the number.

8. Click Move To: Last on the Options bar. (Remember that you aren’t actually moving this line; you’re simply copying it to the last place in the array.)

9. Click the Place button next to the Center of Rotation category on the Options bar, and pick the center of the arc.

10. Pick a point along the first line (the one at the lower left).

11. Pick the second point along the upper-right line.

Your array is complete. Check out Figure 10.41 to see how the finished stairs will look.

**FIGURE 10.41:** The stairs when complete
Now you can begin modeling the stairs. This procedure is nothing more than tracing the lines you've already added to the model. To do this, you'll use the available tools that you haven't touched in the previous staircase. Follow these steps:

1. On the Architecture tab, click the Stairs button.
2. In the Properties dialog box, change Base Level to Level 1.
3. Change Top Level to Level 2.
4. Click Edit Type.
5. Click Duplicate.
6. Call the stairs Corridor Entry Stairs.
7. Click OK.
8. In the Construction category, click the cell to the right of Run Type.
   It contains the text 2" (50 mm) Tread 1" (25 mm) Nosing 1/4" (6 mm)
   Riser. When you click in the cell, you see a […] button. Click it.
9. Choose Cherry for Tread Material.
10. For Riser Material, do the same.
11. Under the Treads category, select Front, Left and Right for the Apply
    Nosing Profile row.
12. Click OK.
13. Scroll down to the Supports category, and change Right Support
    from Stringer (Closed) to Carriage (Open).
14. Click into Carriage – 2" Width (50 mm) to the right of Right Support
    Type.
15. Click the small […] button to the right of the cell.
16. Change Material to Mahogany. Click OK.
17. Change Left Support to Carriage (Open).
18. Add Mahogany as the material to the Carriage – 2" Width. Your
    Properties dialog box should look like the one shown in Figure 10.42.
19. Click OK to get back to the model.
It’s time to add the stairs to the model. To do this, you’ll first sketch the boundary.

1. On the Modify | Create Stairs tab in Sketch Mode, click the Create Sketch button, as shown in Figure 10.43.

2. On the Draw panel, click the Pick Lines icon.

3. Pick the two arcs defining the outside of the stairs. Green arcs are copied directly on top of them.

4. On the Draw panel, click the Riser button.

5. On the Draw panel, click the Pick Lines icon.

6. Pick all of the lines you arrayed. This includes the bottom and the top lines (see Figure 10.44).
7. Click the Stair Path button.

8. Click the Pick Lines button.

9. Pick the centerline of the staircase.

10. Click Finish Edit Mode on the Mode panel.

11. Click the Railing button.

12. Change the railing to Handrail – Pipe, make sure the position is set to Treads, and click OK.

13. Click the Finish Sketch button (the green check mark).

With the stairs roughed in, you need to get a better look at them. If you use the default 3D view, you need to turn off way too many items to see your stairs. Let’s add a perspective view, just to see what’s going on here!

If you’re confident about adding your own perspective view, go ahead and put one in and name it East Entry from Corridor. If not, follow along with these steps:

1. In the Project Browser, go to the Level 1 floor plan.

2. On the View tab, click the 3D View ➔ Camera button.

3. Pick the first point shown in Figure 10.45.

**Figure 10.44:** Picking the detail lines to lay over the stair components
4. Pick the second point shown in Figure 10.45.

5. In the Project Browser, find the new perspective view, and rename it East Entry from Corridor.

6. In the perspective view, turn on Realistic. (It’s located on the View Control bar at the bottom of the view.)

7. Check out the view (see Figure 10.46)!

**Figure 10.45:** Adding the perspective view

**Figure 10.46:** Looking nice
The next series of steps involves mirroring the stairs to the other side of the landing. Then, of course, you need to add a landing railing so people don’t just walk out the door and off the ledge.

1. Go to the Level 2 floor plan in the Project Browser.

2. Select the stairs and the railings, as shown in Figure 10.47.

3. On the Modify | Multi-Select tab, click the Mirror ➢ Pick Mirror Axis button, as shown in Figure 10.48.

4. Pick the center reference plane. (I told you this thing would come in handy.)

Your stairs are now mirrored to the other side of the landing (see Figure 10.48).

**NOTE** To select only the stairs and the railings, you can pick a window around the entire set of lines, groups, railings, and stairs. From there, you can click the Filter button on the Ribbon, and select only Stairs And Railings.
Let’s tie in the railings. If you’re feeling up to the challenge, try it on your own by using the railing Handrail – Pipe. If not, just follow along with these steps:

1. On the Architecture tab, click the Railing button.

2. In the Type Selector, change the type to Handrail – Pipe, as shown in Figure 10.49.

**Figure 10.48:** The mirrored stairs

**Figure 10.49:** Setting the landing handrail type
3. On the Draw panel, click the Pick Lines icon.

4. Set Offset to 4" (100 mm).

5. Pick the landing lines to offset in the railing (see Figure 10.50).

![Figure 10.50: The railing on the landing](image)

6. After the offsets are complete, click the Line icon on the Draw panel. Set Offset to 0.

7. Draw the lines extending from the midpoint snap of the stair railing to the landing railing (see Figure 10.51).

8. Trim the corners so your railings look like Figure 10.51.


10. You may have to flip the railing by selecting it and then clicking the Flip arrow.

11. Add two more railings between the stairs and the brick wall. Your stairs should look like Figure 10.52.

Remember, you must create only one railing at a time. If you try to do more than one continuous line, Revit won't let you proceed. Try creating one short railing and mirroring it.
**FIGURE 10.51**: Connecting the landing railing to the stair railing

**FIGURE 10.52**: The completed landing
Great! You’re getting there. Now you’ll see how a staircase and the accompanying railings come together. For example, it sure would be nice to have a railing with spindles or, better yet, panels added to it. Also, a nice half-round bullnose would improve your staircase. The next section will focus on this concept.

**Stair and Railing Families**

Similar to the model as a whole, stairs and railings comprise separate families that come together to form the overall unit. Although stairs and railings are considered a system family (a family that resides only in the model), they still rely heavily on hosted families to create the entire element.

The next procedure will involve loading separate families into the model and then using them in a new set of stairs and railings that you’ll create in the west wing.

1. In the Project Browser, go to the Level 3 floor plan, and change Detail Level to Fine.

2. Zoom in on the west wing.

3. On the Architecture tab, click the Floor button.

4. In the Properties dialog box, click the Edit Type button.

5. Select the 6” (152 mm) Concrete With 1” (25 mm) Terrazzo floor system from the Type drop-down list, as shown in Figure 10.53.

![Figure 10.53](image)

**Figure 10.53**: You must add a floor at the Level 3 floor plan for the stairs to have a landing.

6. Click OK.

7. On the Draw panel, click the Pick Walls button.

8. Pick the walls, and make sure the lines are set to the core centerline, as shown in Figure 10.54.
9. When picking the south wall, set Offset to 5’–0” (1500 mm) in the Options bar.

**TIP** Again, make sure you have no gaps or overlapping lines. Use the Trim/Extend Single Element command to clean up the lines to look like the figure.

10. Once the sketch lines are in place, trim the corners, and click Finish Edit Mode on the Mode panel.

11. Revit asks if you want to attach the walls that go up to this floor’s bottom. Click No.

12. Revit asks if you want to cut the overlapping volume out of the walls. Click Yes.

Your floor is now in place. The next item you’ll tackle is creating a completely custom railing system.

**Creating a Custom Railing System**

Next, you’ll load the components that make up your stairs. Although Revit makes an attempt to supply you with some families, in this case you’ll download the families included with this book by going to the book’s web page at
www.sybex.com/go/revit2017ner. From there, browse to the Chapter 10 folder and find the following files:

▶ 6210 (2-5_8).rfa
▶ landing.rfa
▶ post.rfa
▶ raised panels.rfa
▶ spindle.rfa
▶ stair nosing.rfa

To get started, you need to load the families into your model so they’re available when it comes time to assemble your new railing. If you remember how to do this, go ahead and load all the families that you just downloaded from the web page. If you need some assistance, follow these steps:

1. On the Insert tab, click Load Family.
2. Find the files that you downloaded from the web page.
3. Select all of them, and click Open to load them.
4. Save the model.

The next step is to create a new railing and add some of these items to it.

1. In the Project Browser, find the Families category, and expand it, as shown in Figure 10.55.

**Figure 10.55:** The railing family called Handrail – Rectangular
2. Find the Railing category and expand it.
3. Find Handrail – Rectangular, and double-click it (see Figure 10.54).
4. Click Duplicate.
5. Call the new railing Wood Railing with Spindles.
6. Click OK.
7. Click OK again.
8. In the Project Browser, under the Families category, scroll down until you see Top Rail Type, as shown in Figure 10.56.

![Figure 10.56: Changing the rail. Note that you can add as many rails as you want. Here, you're adding only one.](image)

9. Double-click the Circular – 1 1/2” (38 mm) Top Rail Type.
10. Click Duplicate.
11. Change the name to 6210, and click OK.
12. Change Profile to 6210 (2-5_8) : 2 5/8” (67 mm).
13. Change Transitions to Gooseneck.
15. Click OK.
16. Under the Families category in the Project Browser, double-click Wood Railing With Spindles, located in the Railing category.
17. Scroll down, and change Top Rail Type to 6210.
18. Click OK.
19. Click the Edit button in the Baluster Placement row.
20. In the Main Pattern area, change Baluster Family to Spindle: 1" (25 mm) (see Figure 10.57).

\[\text{FIGURE 10.57: Adding the spindle to the Main Pattern area}\]

21. Just below the Main Pattern area is the Use Baluster Per Tread On Stairs option. Select it, as shown in Figure 10.58.

22. To the right is the Balusters Per Tread field. Specify two balusters per tread (see Figure 10.58).

23. Change Baluster Family to Spindle: 1" (25 mm), as shown in Figure 10.58.
24. In the bottommost field is the Posts category. Change each of the three posts to None in the Baluster Family column. Your spindles are all you need (see Figure 10.58).

25. Click OK twice.

You may or may not have noticed that you didn’t get the opportunity to change the baluster’s material as you did with the railing. This action must be done in the family itself, as follows:

1. In the Project Browser, the Spindle category is just below Railing, as shown in Figure 10.59. Expand Spindle to expose the 1” (25 mm) family.

2. Double-click the 1” (25 mm) family to open its Type Properties dialog box.

3. Find the Material row, click into the <By Category> field, and click the [...] button.

5. Click OK twice.

This completes the railing setup. Once you add it to the stairs, however, some tweaking will certainly be required. The next step is to customize the stairs themselves.

Creating Custom Stairs

This is the third staircase you’ve created in the same chapter, so you’ve certainly gained some experience regarding the placement of stairs and railings into the Revit model. You’re also becoming familiar with the stair and railings dialog boxes. This last procedure will tie all of that together.

Let’s create that staircase.

1. On the Architecture tab, click the Stairs button.

2. In the Properties dialog box, make sure you choose Cast-In-Place Stair Monolithic Stair, as shown in Figure 10.60, and click the Edit Type button.

![Figure 10.60: Configuring the stairs. As you can see, you have quite a few options.](image-url)
3. Click Duplicate.
4. Call the new staircase Custom Bullnose Stairs.
5. Click OK.
6. Under Construction, next to Run Type, click into the 3/4” Nosing cell, and then click the […] button.
7. Change the nosing profile to stair nosing: stair nosing.
8. Apply the nosing profile to Front, Left and Right.
9. Select the Riser check box.
10. Change the riser thickness to 3/4” (19 mm).
11. For Riser To Tread Connection, choose Extend Tread Under Riser.
13. Under Treads, make sure Treads is turned on.
16. Click OK.
17. Click the 7” (178 mm) Thickness cell next to Landing Type, and click the […] button to the right.
18. Click Duplicate.
19. Call the new landing 1’-0” (300 mm) Mahogany Landing.
20. Change Monolithic Thickness to 1’-0” (300 mm).
22. Click OK.
23. Click OK again.

It’s time to configure some of the layout properties. These will allow you to calculate the rise/run count as well as some basic offsets you’ll need.

1. In the Properties dialog box, set Base Level to Level 1.
2. Set Base Offset to 6 5/8” (152 mm), as shown in Figure 10.61.
3. Set Top Level to Level 3. (Yes, this is going to be one long staircase!)
The next step is to place this monster into the model. Although you didn’t specify a multistory staircase, you’ll need multiple landings to give your visitors a breather as they travel up the stairs. This layout will require a little more care in the initial planning stage.

1. On the Work Plane panel, click the Ref Plane button.

2. Click the Pick Lines button, and then offset a grid, as shown in Figure 10.62.

The nice thing about using reference planes while in Sketch Mode is that they will disappear once you finish the sketch. If you need to go back and edit the stairs, the reference planes will appear again!

**Figure 10.61:** The Base Offset value is set to 6 5/8" (152 mm).

**Figure 10.62:** Using dimensions to lay out the centerlines of the stairs
3. Click the Railing button.

4. Change the railing type to Wood Railing With Spindles, and make sure Position is set to Treads. Click OK.

5. On the Modify | Create Stairs tab in Sketch Mode, click the Run button.

6. Draw your stairs as shown in Figure 10.63. (Pick the points as the figure is sequenced.)

![Diagram showing the process of drawing stairs](image)

**Figure 10.63**: Picking the intersections of the reference planes to determine where the stairs will go

7. Verify that your plan looks like Figure 10.64.

![Diagram showing the final stairs setup](image)

**Figure 10.64**: The stairs in place
8. Click Finish Sketch. Your stairs should look like Figure 10.65.

![Figure 10.65](image-url)

**Figure 10.65**: The stairs as shown in plan

9. Go to a 3D view to check out the stairs. They should resemble Figure 10.66.

![Figure 10.66](image-url)

**Figure 10.66**: The stairs as shown in 3D. Notice the nice bullnose and the railings.
The next step (pun intended) is to add a landing to the bottom of the stairs. This requires creating a family. Although we will cover creating families in Bonus Chapter 2, “Creating Families,” this one has been created, and you’ve downloaded the families needed to create this step in the stairs.

**Adding a Custom Landing**

You left the 6 5/8” (152 mm) offset for the bottom tread because you need to introduce your own version of how that bottom tread should look. If you haven’t already loaded the family, go to www.sybex.com/go/revit2017ner. From there, browse to the Chapter 10 folder and find the Landing.rfa and Post.rfa files. After you’ve loaded the families, proceed with these steps:

1. In the Project Browser, go to the Level 1 floor plan.
2. On the Architecture tab, click the Place A Component button.
3. In the Type Selector, find and select the Landing family.
4. As you’re inserting the family, press the spacebar to rotate the landing into the correct position.
5. Place the landing under the last tread at the point shown in Figure 10.67.

![Figure 10.67: Placing the landing](image)

6. Press Esc twice.
7. Select the landing.
8. In the Properties dialog box, change Tread Material to Cherry.
9. Change Base Material to Mahogany, and click OK (see Figure 10.68).
The next task is to add a post.

**Adding a Gooseneck**

In this style of railing system, it would be nice to have a gooseneck to catch the railing as it slopes downward and spiral it into the post. Of course, Revit doesn't have families for this built in, but this book does! If you didn’t download the post family earlier in this chapter, go to the book’s web page, browse to the Chapter 10 folder, and find the Post_up.rfa file. After you download it and load it into the model, follow these steps:

1. In the Project Browser, go to the Level 1 floor plan, and zoom in on the landing area, as shown in Figure 10.69.

2. On the Architecture tab, click the Place A Component button.

3. In the Properties dialog box, select Post_up With Gooseneck.

4. As you’re placing the post, press the spacebar twice to flip it into the correct orientation.

5. Place it on the landing slightly away from the stair railing.

6. Select the post, and change Offset to 6 5/8” (152 mm) in the Properties dialog box.

**Note** If the end of the post seems to be clipped in the plan, you need to adjust the view range in the Properties dialog box. Right now, the 4’–0” (1200 mm) clip plane may be a tad too low. To fix this, find the View Range row in the Properties dialog box and click the Edit button. In the View Range dialog box, adjust Cut Plane Offset to 4’–6” (1250 mm).
7. Select the post again (if it’s not still selected).

8. Click the Move button.

9. Move the post from the midpoint of the post’s end to the midpoint of the stair railing’s end, as shown in Figure 10.70.
10. Select the post again (if it’s not selected already).

11. In the Properties dialog box, go to the Materials And Finishes category, and change materials for both the rail and the post to Cherry.

12. Mirror the post to the other railing.

In 3D, your landing should now look like Figure 10.71.

**Figure 10.71:** The completed landing

---

**Adding a Railing to the Landing**

Let’s add the railing to the Level 3 balcony. Compared to that landing you just did, this is going to be a snap! If you feel as though you have the experience required to add your own landing railing, take a shot at it. If not, follow these steps:

1. In the Project Browser, go to Level 3.
2. Zoom in on the stairs.
3. Right-click one of the railings on the stairs, and click Create Similar.
4. Sketch a railing that is 4” (100 mm) in from the face of the landing, as shown in Figure 10.72.
5. Make sure you have a “leg” tied into the stair railing.


7. Repeat the procedure on the other end (see Figure 10.73).

**NOTE** To repeat the procedure on the other end, either you can mirror the railing you just put in and then edit it to reach the far end of the landing or you can start the Railing command and do it again. I recommend mirroring the railing, selecting the new railing, and then selecting Edit Path from the Modify | Railings tab. You can then grip-edit the right end to meet the wall. This assures you that the railing will be aligned with the railing on the stair.
The last step is to add a raised-panel stile and rail system along the third-floor wall.

**Adding a Raised-Panel Stile and Rail System**

The first thing you'll need to do is to add an entrance to the large Level 3 training room. The corridor will then receive a custom line-based, raised-panel family.

1. In the Project Browser, go to the Level 3 floor plan.
2. On the Architecture tab, click the Door button.
3. In the Properties dialog box, select Single-Raised Panel With Sidelights: 36” × 84” (86 mm × 2134 mm).
4. Place it in the corridor wall aligned with the stairs, as shown in Figure 10.74.

![Figure 10.74: Pick the point as shown for the elevation.](image)

5. Copy the door 10′–0″ (3000 mm) to the right (see Figure 10.73).
6. On the View tab, click the Elevation button.
7. In the Change Element Type menu in the Properties dialog box, select Interior Elevation.
8. Pick a point, as shown in Figure 10.75; then press Esc.
9. In the Project Browser, right-click the new elevation, and rename it West Wing Balcony Elevation.
10. Open the West Wing Balcony elevation.
11. Stretch the crop region so that you can see the entire west wing.
12. On the Architecture tab, click the Place A Component button.
13. Scroll down the Type Selector list until you find Raised Panels (see Figure 10.75).
14. In the Work Plane dialog box, make sure Pick A Plane is selected, and then click OK.

15. Pick the far wall (see Figure 10.75). If you don’t have the raised panel family, you can download it at the book’s web page; it’s called Raised Panel.rfa. Once it’s downloaded and loaded into the model, proceed with the next step.

16. On the Modify-Place Component tab, click the Place On Work Plane button, and pick the base point shown in Figure 10.76.
17. Pick the second point.

**NOTE** If you can’t seem to pick the points specified in Figure 10.75, go ahead and pick two points close to the area indicated in the figure. After you place the line-based family, you can select it and grip-edit the ends to extend to the wall’s edges as shown in the figure. Also, if the panels are too high, simply move them down to the floor or align them after the panels are in place.

18. Start the Place A Component command again, if it’s not already running, and add the raised-panel family between the two doors and to the right. This completes the raised panels for this level.

19. Select all the raised panel families on this floor (remember to hold the Ctrl key to add to the selection).

20. In the Materials And Finishes category of the Properties dialog box, change Frame Material to Cherry.

21. Change Panel Material to Mahogany. See Figure 10.77.

![Figure 10.77: Changing the material](image)

22. Change Visual Style to Realistic. Your elevation should look like Figure 10.78.
Wow! That was quite a bit about stairs. If you take anything away from this chapter, it should be the knowledge that stairs don’t come easy, but you can create any staircase if you know you’ll need to create families.

The last section of this chapter focuses on adding ramps to the model. As far as Revit procedures go, ramps are the kid sister to stairs.

**Adding Ramps**

When you think of a ramp in Revit, think of a one-tread, one-rise staircase at a 1/12 pitch. A ramp is placed in the model exactly the same way as a set of stairs. You still have the run method, and you can still sketch the ramp by using a boundary.

That being said, let’s start placing a ramp in your model.

1. In the Project Browser, go to the Level 1 floor plan.
2. Zoom in on the radial entry of the east wing at grid intersection F-5 (see Figure 10.79).
3. You need to create a flat landing, so, on the Architecture tab, click the Floor button.
4. Click Edit Type in the Properties dialog box.
5. Select Generic – 12” (305 mm) Filled.
6. Click Duplicate.
7. Call the new floor Exterior Concrete Slab.
8. Click OK.

9. Click the Edit button in the Structure row.


11. Change Thickness to 6” (150 mm).

12. Click OK twice to get back to the model.

13. Place the concrete at the points shown in Figure 10.78.

**WARNING** Make sure you’re using Pick Lines Mode and are picking the outside face of brick. That extra line represents the water table above this floor’s level.

14. When the slab is in place, click the Finish Edit Mode button.

15. Click No in the next dialog box.

Now you can add the ramp. You’ll set the ramp’s properties for the top to Level 1, and the bottom will also be at Level 1 but with an offset.

1. On the Architecture tab, click the Ramp button.
2. In the Properties dialog box, click Edit Type.

3. Click Duplicate.

4. Call the new ramp Exterior Concrete Ramp.

5. Click OK.

6. Give it a 6” (150 mm) thickness.

7. Change Function to Exterior.

8. For the ramp material, click the […] button, and specify Concrete – Cast-In-Place Concrete, as shown in Figure 10.80.

9. Notice that Maximum Incline Length is set to the ADA standard of 30’-0” (10000 mm).

10. In the Other category, notice that Ramp Max Slope is set to 1/12.

11. Click OK.
12. In the Properties dialog box, set Base Level to Level 1.

13. Set Base Offset to -2’–6” (-750 mm), as shown in Figure 10.81.

![Properties dialog box](image)

**Figure 10.81:** Setting the properties

14. Set Top Level to Level 1.

15. Set Width to 5’–0” (1500 mm) (see Figure 10.81).

16. On the Draw panel, click the Run button.

17. In the model, click the first point for the ramp, similar to the point shown in Figure 10.82. (You have to place the point near the midpoint. Revit doesn’t allow you to snap while in Sketch Mode.)

18. Move your cursor down the view (south) 15’–0” (4500 mm), as shown in Figure 10.82. (You’ll see the temporary dimension.)

19. Pick a point about 6’–0” (1800 mm) below the end of the ramp, in alignment with the right boundary, as shown in Figure 10.83. After you pick the second point, the view should read “30’ (10000 mm) of inclined ramp created, 0 remaining.”
20. Move your cursor to the right until the ramp stops (see Figure 10.83).

21. On the Modify | Create Ramp tab in Sketch Mode, click the Railing Type button.

22. Select Handrail – Pipe in the Railing Type dialog box that opens.

23. Click OK.

24. Click Finish Edit Mode.
25. Select the entire ramp (including the railing).

26. Move the ramp so that the midpoint of the top of the ramp meets the midpoint of the landing slab.

You may notice immediately that the ramp is sloping in the wrong direction. Also, you need to tie the railings into the slab. If you would like to pick around and see how to do these things on your own, go right ahead. Otherwise, follow these steps:

1. Select the ramp.
2. Pick the small blue arrow—this flips the direction of the ramp.
3. On the Architecture tab, click the Railing button.
4. In the Properties dialog box, click Edit Type, change the type to Handrail – Pipe, and click OK.
5. Draw a railing 8" (200 mm) in from the slab edge, as shown in Figure 10.84.

**Figure 10.84**: Adding the railing just as you’ve been doing this entire chapter

It’s best if you keep moving your cursor past the end of the ramp. This ensures that the entire ramp has been put in place.
6. Mirror the slab, the ramp, and the railing to the other side of the building, as shown in Figure 10.85.

![Figure 10.85: The two ramps](image)

7. Save the model.

Creating ramps is necessary in almost every project. Some will be easier than others, and, at times, they may try your patience. Keep at it, and before long you’ll have the experience you need to feel confident in creating ramps.

**Are You Experienced?**

**Now you can...**

- ✓ create stairs with the conventional method by using the Run command to generate the height and length you need
- ✓ create stairs by first laying out the geometry by placing line work in the model and then tracing over the lines with the stair components
- ✓ determine the difference between the boundary and the riser when you need to sketch the stair profile
✔ load necessary components used to customize stairs and railings such as railing types, spindles, posts, and landings

✔ use separate components and access them in the Project Browser to place materials

✔ configure railings based on the baluster placement and the railing placement as used in the Element Properties of the railing

✔ determine how to tie a railing into a stair railing by using offsets and by aligning the railing sketch with the stairs

✔ add a line-based, raised-panel family to complete millwork items

✔ create ramp landings and create the actual ramp

✔ determine the length of the ramp based on the rise and run of the slope